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User’s Guide

For the ALS Learner:

Welcome to this Module entitled Digital Applications – Spreadsheets under Learning Strand 6 Digital 
Citizenship of the ALS K to 12 Basic Education (BEC).

This module was designed to provide you with fun and meaningful opportunities for guided and independent 
learning at your own pace and time. You will be enabled to process the contents of the learning resource while 
being an active learner.

This module has the following parts and corresponding icons: 

Let’s Get to Know This will give you an idea of the skills or competencies you are expected to 
learn in the module.

Pre-assessment
This part includes an activity that aims to check what you already know 
about the lesson. If you get all the answers correct (100%), you may decide 
to skip this module.

Setting the Path This section provides a brief discussion of the lesson. This aims to help you 
discover and understand new concepts and skills.

Trying This Out
This comprises activities for independent practice to solidify your 
understanding and skills of the topic. You may check the answers to the 
exercises using the Answer Key at the end of the module.

Understanding 
What You Did This includes questions that process what you learned from the lesson.

Sharpening 
Your Skills

This section provides an activity that will help you transfer your new 
knowledge or skill in real-life situations or concerns.

Treading the 
Road to Mastery

This is a task which aims to evaluate your level of mastery in achieving the 
given learning competency.

Don’t Forget This part serves as a summary of the lessons in the module.

Explore More In this portion, another activity will be given to you to enrich your knowledge 
or skill of the lesson learned. This also tends retention of learned concepts.

Reach the Top This part will assess your level of mastery in achieving the learning 
competencies in each lesson in the module.

Answer Key This contains answers to all activities in the module.

Glossary This portion gives information about the meanings of the specialized words 
used in the module.



At the end of this module you will also find:

References This is a list of all sources used in developing this module.

The following are some reminders in using this module:

1.	 Use the module with care. Do not put unnecessary mark/s on any part of the module.  
Use a separate sheet of paper in answering the exercises.

2.	 Don’t forget to answer the Pre-assessment before moving on to the other activities  
included in the module.

3.	 Read the instruction carefully before doing each task.
4.	 Observe honesty and integrity in doing the tasks and checking your answers.
5.	 Finish the task at hand before proceeding to the next.
6.	 Return this module to your ALS Teacher/Instructional Manager/Learning Facilitator  

once you are through with it.

If you encounter any difficulty in answering the tasks in this module, do not hesitate to consult your ALS 
Teacher/Instructional Manager/Learning Facilitator. Always bear in mind that you are not alone.

We hope that through this material, you will experience meaningful learning and gain deep understanding of 
the relevant competencies. You can do it!
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1SPREADSHEETS

We deal with numbers every day. For example, we budget our money 
for our food, fare, clothing, and other expenses. 

	 Calculating numbers is a skill we can easily do and apply in our daily 
lives, but what if you need to calculate larger numbers and bigger sums such as 
in banks, department stores, supermarkets, grades, or payrolls? This is where 
a spreadsheet program take part as it helps in computing and organizing 
data.

	 This module will walk you through how to use spreadsheets to help 
you get familiar with it. The following are the three lessons in this module:

Lesson 1 – Understanding Spreadsheets 
Lesson 2 – Using Formula and Formatting Cells
Lesson 3 – Inserting Charts and Finalizing Spreadsheets

%

X

+
-

Let’s get to know
MODULE 3



 2 DIGITAL APPLICATIONS

Directions: Choose the correct answer in the parenthesis to complete the 
statement. Write your answers on a separate sheet of paper.

1.	 Rows are a range of (horizontally, vertically) aligned cells represented 
by numbers in a spreadsheet.

2.	 Columns are a range of (horizontally, vertically) aligned cells represented 
by letters in a spreadsheet.

3.	 In moving a cell content, use the (copy, cut) command.
4.	 (Box, Cell) is the individual intersection between rows and columns.
5.	 Bold, Italic, Bold Italic, and Underline are (font styles, font types).
6.	 Arial, Times New Roman, and Verdana are examples of (font styles, 

font types).
7.	 Spreadsheet or worksheet is an arrangement of (boxes, cells) in 

columns and rows.
8.	 To put a background color for a cell, you need to use the (Fill Color, 

Font Color) command.
9.	 Left, center, and right are (horizontal, vertical) alignments.

10.	 Addition, subtraction, multiplication, and division are 
(mathematical, logical) operations.

11.	 The (Line Chart, Pie Chart) is used for easy comparison of 
proportions.

12.	 (Formulas, Functions) are predefined formula in Microsoft Excel.
13.	 (Comma, Point) is the separator used in accounting number format.
14.	 A function that is used to compute the total of all items in the 

specified range is called (Sum, Total).
15.	 A command called (Fill Cell, Fill Color) is used to change the 

background color of a cell.

Did you get all the answers correct? It is okay if you did not, especially 
if this is the first time you encountered those words and statements. This 
module will help you understand spreadsheets and their uses.

PRE-ASSESSMENT
MODULE 3



3SPREADSHEETS

UNDERSTANDING 
SPREADSHEETS

After this lesson, learners should be able to

use the spreadsheet application to generate 
different documents;

create a new spreadsheet based on the different 
available templates;

demonstrate how to save a spreadsheet under 
another name, as another file type, and to a 
location on a drive;

distinguish the different uses of magnification 
or zoom tools;

determine the use of the different toolbars;

Setting the Path
lesson 1



 4 DIGITAL APPLICATIONS

demonstrate understanding of using cells in 
a spreadsheet;

apply the process of modifying rows and 
columns; and

customize worksheets.

Lesson 1



5SPREADSHEETS

Directions: Identify and locate the contents in the cell references below. 
Write your answers on a separate sheet of paper.

1.	 A1
2.	 C2
3.	 B6
4.	 E3
5.	 C5 to C11

6.	 A4
7.	 A7
8.	 E8
9.	 D4

10.	 D6

Were you able to locate the contents? If yes, this is how you will be 
working with cells in a spreadsheet. This is one of the basic ways to familiarize 
yourself to spreadsheets.

Let’s try this

TRYING THIS OUT
Lesson 1



 6 DIGITAL APPLICATIONS

SPREADSHEET

	 A spreadsheet or worksheet is an arrangement of cells in columns and 
rows used to organize, analyze, calculate, and report information, usually 
in numerical form. Spreadsheet software programs are considered unique 
because they can calculate values using mathematical formulas and data in 
the cells.

	 Like word processors, many applications are used to create spreadsheets. 
Below is a list of the most common spreadsheet applications and their 
operating system where these programs can be opened.

ICONS
SPREADSHEET 

PROGRAM
OPERATING SYSTEM

Microsoft Excel Windows

Understanding What You Did
lesson 1



7SPREADSHEETS

ICONS
SPREADSHEET 

PROGRAM
OPERATING SYSTEM

Quattro Pro Windows

iWork Numbers Apple MacOS

OpenOffice Calc Any

Google Sheets Any

USES OF SPREADSHEET

	 Spreadsheets are mostly used in accounting and recording data, such as 
preparing budgets, recording students’ grades, preparing financial statements, 
analyzing numbers, managing inventory, or making forecasts. Spreadsheets 
can be used at home, in school, in work, or in business.

GETTING FAMILIAR WITH THE SPREADSHEET

	 One of the most used spreadsheet programs is Microsoft Excel (MS 
Excel) from the Microsoft Office productivity tools. Though spreadsheets 
vary, their features are almost the same.

	 This module will use Microsoft Excel 2019 in getting familiar with 
spreadsheet applications. 

Lesson 1
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PARTS OF A SPREADSHEET

	 Let us get to know the parts of Microsoft Excel before creating 
spreadsheets. To open Microsoft Excel, look for the Excel logo in your 
desktop or search using the search bar and then double-click. Spreadsheets 
are contained in a file called workbook. In Microsoft Excel, Book with a 
number beside it (in this case “Book1”) refers to the spreadsheet’s file name. 
The basic parts of the Microsoft Excel are row, column, cell, active cell, cell 
address, and formula bar. 

Sheet Tab

Lesson 1
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9SPREADSHEETS

Rows. The horizontally aligned cells in a spreadsheet, identified 
with numbers (row header).

Columns. The vertically aligned cells in a spreadsheet, identified 
with letters (column header).

Cell. An individual intersection between rows and columns, 
labeled by the row number and column letter.

Active cell. The cell currently being edited, marked by a thick black 
border around the cell.

Cell address. Also called cell reference, an alphanumeric value used 
to identify a specific cell.

Formula bar. Shows the contents of the active cell and allows you 
to create and view formulas.

Sheet tabs. Contains the names of the available worksheets in the 
current workbook.

Lesson 1



 10 DIGITAL APPLICATIONS

OPENING AND CLOSING 
A SPREADSHEET APPLICATION

1.	 To launch or open a spreadsheet application, double-click the 
spreadsheet icon in the desktop if it is available. For example, you will 
see the Excel icon is in the desktop.

2.	 You may also use the search bar on the taskbar. Type the name of the 
spreadsheet application you are looking for. For example, type Excel; 
if there is a result, click it to launch.

3.	 To open a new workbook, click New on the right side of the screen 
then select Blank workbook.

4.	 To close a spreadsheet application, click the Close button on the upper 
right corner of the screen.

Lesson 1
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Lesson 1
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CREATING A NEW SPREADSHEET BASED ON THE 
AVAILABLE TEMPLATES

	 Microsoft Excel allows users to use available templates with formatting 
and predefined formulas. You can browse different templates, depending 
on the type of spreadsheet you want to create, such as record lists, budgets, 
calendars, schedules, inventory lists, and plans. 

	 You can also click on the suggested searches to display more templates 
or search online templates if you are connected to the internet; just type the 
word related to the template you are looking for.

Lesson 1



13SPREADSHEETS

1.	 Click Personal in the suggested searches.

2.	 Select Personal Monthly Budget. Once it is selected, a window will 
appear with details about the template. Click Create.

Lesson 1
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3.	 Once Excel loads the 
selected template, you will 
see two sheets: Start and 
Personal Monthly Budget.  
 
Click the Personal Monthly 
Budget sheet.

4.	 To edit, click the cells and 
change to your desired 
contents.

Loaded Personal Monthly Budget Template

Lesson 1
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Personal Monthly Budget Sheet

5.	 Templates can still be modified according to the preferred data.
6.	 If you do not like the templates, you can always go back and use a blank 

workbook.

Lesson 1
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Blank Workbook

Lesson 1
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SAVING A WORKBOOK

1.	 To save a new workbook, press Ctrl+S on the keyboard. You can also click 
the Save button  on the upper left corner of the workbook, or click the 
File tab then select Save.

2.	 A dialog box will appear, asking for a File Name and Choose a Location 
where the file will be stored. If you are going to locate a folder, click the 
drop-down arrow on Choose a Location or click More save options to 
look for other locations. Enter your desired file name and press Save.

Let us save the file as My First Workbook.

Lesson 1
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3.	 Notice that the file name on the upper left corner has changed from 
“Book1” to “My First Workbook.”

Spreadsheets in Microsoft Excel are usually saved in the Documents 
folder  as XLSX. 

4.	 You can also save the file in a different location, with a different file 
name, and file type. Just click on the File tab then select Save As.

5.	 To save under a different file name, delete the current filename and 
type a new one. You can also save it as a different file format, just click 
the drop-down arrow on the file type and select the desired file type. 

Lesson 1
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Different Available File Types

It can be saved as a template, Portable Document Format (PDF), web 
page, rich text format, or any file type you want to use.

6.	 Click Browse to choose the folder or drive where you want to save the 
file. A window will appear where you can locate your folder or drive. 
Choose a location then click Save to finish the process.

Lesson 1
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Lesson 1
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SWITCHING BETWEEN OPEN SPREADSHEETS

There are several ways to switch between files. 

USING THE SWITCH WINDOWS BUTTON

1.	 One option to switch between the open Excel files is to use the View 
tab on the ribbon. Go to the View tab and click on  Switch Windows.

2.	 Pick the workbook you would like to move from the list of available 
open files. There will be a check next to the file that you are currently 
viewing for easy reference. In the example below, there are two open 
spreadsheets: Book 1 and Book 2. Choose among the open spreadsheets 
you want to switch with by clicking it.

Lesson 1
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USING KEYBOARD SHORTCUTS

	 To move back and forth between any open windows (of all file types 
and browsers), use the combination Alt+Tab. Hold Alt and press Tab to 
browse through the files until you get to the file you are looking for.

CLICKING THROUGH THE TASKBAR

	 Click the icon of the spreadsheet application on the taskbar. A small 
window will appear. Then, select the file you want to open.

USING AVAILABLE HELP FUNCTIONS

	 The help feature in Microsoft Office applications is usually the fastest 
and easiest way to get help. In Windows, access it by pressing F1 in the 
application or just click the Help tab.

Lesson 1
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	 Once the help feature 
opens, use the search feature 
in the right-side task pane to 
find answers to your questions 
related to the use of spreadsheet 
programs. To browse for topics, 
open Recommended Topics. 

Lesson 1
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1.	 The default view is 100%, but 
you can adjust this by clicking 
Zoom. A window with different 
levels of magnification to choose 
from will pop out, including Fit 
Selection and Custom.

2.	 Zoom to Selection will allow 
you to zoom the document up 
to 400%, which is the maximum 
magnification. This helps you 
focus on a specific area of the 
sheet.

Zoom tools are available in most 
applications such as Microsoft Word, 
Microsoft Excel, and Microsoft 
PowerPoint. Zoom tools let you zoom 
in or out your documents, workbooks, 
or presentations while working on 
them. You can find the zoom tools 
under the View tab of the application.View Tab Zoom Group in Excel

Lesson 1
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Zoom to Selection View

3.	 Alternatively, the zoom slider is available for instant zoom in and zoom 
out. It is located at the lower right corner of the workbook.

Zoom Slider

Lesson 1
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USING RIBBONS, TABS, AND 
THE QUICK ACCESS TOOLBAR

	 Ribbons are designed to help you quickly find the command that you 
want to execute in Microsoft Office. Ribbons are divided into logical groups 
called tabs, and each tab has its own set of groups with unique functions to 
perform. There are various tabs: Home, Insert, Page Layout, Formulas, Data, 
Review, and View.

	 Ribbons can be hidden when you collapse or minimize ribbons. Right-
click on the ribbon area and choose Collapse the Ribbon.

When you hide the ribbon, only the tabs will be displayed. Ribbons 
will only appear if you select a tab.

Lesson 1
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To restore the Ribbons, click 
the Ribbon Display Options at the 
upper right of the workbook then 
select Show Tabs and Commands.

The Quick Access Toolbar 
is a universal toolbar that is always 
visible and is not dependent on the 
tab that you are working with. It lets 
you execute commands easily.

Ribbon Display Options

Quick Access Toolbar

The default commands are the save, 
undo, and redo buttons. You can customize 
the toolbar by clicking on the drop-down 
button at the right of the toolbar and then 
checking the desired commands to be 
included on the Quick Access Toolbar.

Lesson 1
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USING SPREADSHEET CELLS

	 As aforementioned, a cell is made up of a row and a column. Each cell 
should only contain one element of data. If you are ready to insert data or 
content, click a cell.

1.	 Click the cell to insert data such as numbers, dates, and texts. Let us 
put data in cells A1 to A5.

To organize your workbook, starting at the left corner of the sheet is 
recommended.

2.	 Let us put names as text beside each number in cells B1 to B5.

3.	 Then, insert birthdates on C1 to C5 in mm/dd/yyyy format.

Lesson 1
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Notice that the inserted date can be seen in the formula bar.

4.	 If the data is longer than the width, put your cursor on the right side of 
the header and drag to adjust the column headers. Use the same process 
to adjust the rows.

Lesson 1
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CREATING LISTS

	 When creating lists of data in a spreadsheet, remember the basics to 
for better results. Examine the sample illustrations below.

1.	 Avoid blank rows and columns in the main body of the list. It may look 
unpleasing to the eye, and the data may look disorganized.

2.	 If your list needs to have a total row like the example on the next page, 
it is best to put a blank row before the total row to separate the final 
data from the main list.

3.	 Ensure that the cell bordering lists are blank. It is better not to put 
borders to main lists to avoid confusion, especially if you are going to 
insert rows between data in the future. Apply No Border found on the 
Font group to remove the cell borders.

Lesson 1
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Step 2. Insert a Blank Row Before the Total Row

Step 3. Ensure Cell Bordering Lists are Blank.

Lesson 1
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cells, click each cell while holding the Ctrl key on the keyboard.

Selecting Nonadjacent Cells

4.	 If you want to select the entire worksheet, click the triangle at the 
corner of A1.

SELECTING CELLS AND WORKSHEETS

1.	 To select a single cell, click the cell using your mouse or use the arrows 
keys on the keyboard.

2.	 To select a range of cells, hold 
the left button of your mouse and 
drag from the start of the range 
up to the end. You may also use 
the arrow keys while holding  
the Shift key in the keyboard.

3.	 To select a nonadjacent cell or 

Lesson 1
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Selecting the Entire Worksheet

COPYING AND MOVING CELL CONTENTS

1.	 To copy cell content, follow the steps we previously discussed on selecting 
cells then click Copy in the Clipboard group on the Home tab, or press 
Ctrl+C on your keyboard. You can also right-click on the selected cells 
and choose Copy.

Lesson 1
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2.	 Select the cell or cells where you want to paste the content then click the 
Paste command on the Home tab, or press Ctrl+V on your keyboard. 
Alternatively, right-click on a blank cell, choose Paste Options, and click 
Paste.

Pasting content

Successful paste

3.	 To move contents in a cell, select the cell or cells to be moved then click 
Cut on the Home tab. You may also press Ctrl+X on the keyboard, or 
right-click on the selected cells and choose Cut. The Cut command will 
remove the contents from its origin and transfer them to your chosen cell.

4.	 Select the cells where you want to move your content then click Paste. 

5.	 You can also copy or move cell contents from one sheet to another or 
between open workbooks. Do the same procedure in copying contents 
in a worksheet.

Lesson 1
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Step 4. Successful Paste

Step 3. Moving Contents in a Cell (Cutting Contents)

Step 5. Copying or Moving Cell contents from One Sheet to Another or 
Between Open Workbooks

Lesson 1
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USING THE AUTOFILL TOOL

	 Instead of entering data manually, Microsoft Excel has a feature called 
AutoFill that lets you fill cells automatically. It may either follow a pattern 
or base on data from other cells.

1.	 To use AutoFill, let us enter a text in a cell. In this example, let us 
type a month, say, January.

2.	 Point your mouse on the lower right corner of the cell. You should see 
a solid cross pointer; this is called the fill handle.

6.	 To remove or delete cell contents, select the cells to be deleted then press 
Del on the keyboard.

Lesson 1



37SPREADSHEETS

3.	 Hold the mouse’s left button and 
drag down the pointer. You will 
be guided by a tool tip indicating 
the next content.

4.	 AutoFill Options will appear 
after your use the fill handle. 
When you click the button, the  
options for AutoFill will be 
displayed.

AutoFill Options

5.	 The default selection is Fill 
Series. Copy Cells will not follow 
a pattern; it will only copy the 
selected word.

Lesson 1
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If you want to copy the 
format of the cell but not the 
content, choose Fill Formatting 
Only. If you want to copy the 
content of the cell but not the 
format, choose Fill Without 
Formatting.

Autofill can also be done 
horizontally; just follow the 
same steps, but this time, drag 
your mouse to the right.

Copy Cells AutoFill Option

Fill Formatting Only Fill Without Formatting

Lesson 1
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AutoFill can add incremental data entries if the data is numerical or 
alphanumeric. Enter any starting value in a cell. Enter the next value in the 
cell below it to establish a pattern. Select those two cells and drag the bottom 
fill handle down the column to create a series of incremental numbers.

For example, entering 12 and 24 in cells A1 and A2 would create the 
series 12, 24, 36, 48, 60 when copied down to cell A5.

For alphanumeric, the fill handle will create incremental data. Enter 
a starting value in any cell and use the fill handle vertically or horizontally.



Lesson 1



 40 DIGITAL APPLICATIONS

SELECTING ROWS AND COLUMNS

1.	 To choose a row or a column, click the row header (number) or column 
header (letter). 

2.	 To click more than one row or column, click and hold the headers, hold 
the left button, and drag the mouse vertically or horizontally.

3.	 To select nonadjacent rows and columns, click the headers of the 
desired rows and columns while pressing the Ctrl key on the keyboard.

Lesson 1
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ADJUSTING ROW HEIGHT AND COLUMN WIDTH

1.	 To adjust the row height, select the row headers to be adjusted and 
then point your mouse to the last selected row header. Double-click 
or resize it manually by holding the left button while dragging down 
the headers.

2.	 To adjust the column width, select the column headers to be adjusted 
and then point your mouse to the last selected column header. Double-
click or resize it manually by holding the left click while dragging the 
headers to the left or to the right.

SCREENSHOT 07

Lesson 1
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INSERTING AND DELETING ROWS AND COLUMNS

2.	 To insert more than one row, select the desired number of row headers 
and click Insert. The selected rows correspond to the number of new rows.

1.	 To insert a row in between, right-click on the row header and click Insert.

Lesson 1
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3.	 To insert a column in between, right-click the column header and 
click Insert.

4.	 To insert more than one column, select the desired number of column 
headers then click Insert. The selected columns correspond to the 
number of new columns.

Lesson 1
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5.	 To delete cells, do the same procedure in inserting rows or columns, but 
instead of Insert, click Delete.

FREEZING AND UNFREEZING PANES

2.	 To freeze the first column, click Freeze First Column; to freeze the  
top row, click Freeze Top Row. You will see a faint line between the first 
column and the second column. It indicates that the first column was 
locked or frozen.

1.	 To keep an area of a worksheet visible while you scroll to another area of 
the worksheet, go to the View tab and click Freeze Panes to lock specific 
rows and columns in place.

Lesson 1
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3.	 Aside from the first column, you can also freeze two or more columns 
and rows. Example if you want to freeze the first and second column, 
you need to choose the third column and then click Freeze Panes on 
the View tab.

Lesson 1
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4.	 The same procedure will be applied for the rows. Freezing panes is very 
helpful if you are working with big or long worksheets. The effect will be 
seen upon scrolling from left to right or from up to down.

5.	 To unfreeze the panes, 
simply click Unfreeze 
Panes.

Lesson 1
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CUSTOMIZING 
WORKSHEETS

	 You can only see one 
worksheet upon opening a 
workbook, and its default name  
is “Sheet1.” You can add more  
sheets, and each sheet added 
will have their names change 
incrementally. 

ADDING WORKSHEETS

1.	 To add another sheet, click the plus sign button beside Sheet1.

2.	 A new sheet will appear with Sheet2 as the name. You can continue 
doing this if you need more worksheets.

Lesson 1
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2.	 Do the same procedure to all the worksheets that you will add.

3.	 To switch between worksheets, just click the sheet that you want to work 
on.

RENAMING A WORKSHEET

1.	 To rename a worksheet, right-click on the worksheet to be renamed then 
select Rename. Type a meaningful worksheet name that is related to your 
task. Let us rename our worksheet to “Sample 1” and “Sample 2.”

Lesson 1
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COPYING, MOVING, AND DELETING WORKSHEETS

1.	 To copy a worksheet, right-click the worksheet to be copied then click 
Move or Copy...

2.	 A dialog box will appear with 
a list of existing worksheets. 
Check Create a copy.

3.	 A duplicate worksheet will 
appear with the same name but 
with “(2)” because Excel does 
not accept worksheets with the  
same names. You can also change 
it to your desired name.



Lesson 1
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4.	 To move worksheets, right-
click the sheet to be moved then 
select Move or Copy and choose 
(move to end). Click OK.

Here, Sample 3 was moved to the  
end after all the existing sheets. 
Moving can also be as easy as 
dragging the worksheet to your 
desired place.

5.	 To delete a worksheet, click the worksheet to be deleted, right-click, and 
then choose Delete.

Microsoft Excel has a Graphical User Interface (GUI) that facilitates 
easy navigation among cells and worksheets.

Lesson 1
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I.	Directions: Identify the parts of Microsoft Excel. Write your answers on a 
separate sheet of paper.

1

2

3

4

5 8

9 10

6

7

Sharpening Your Skills
lesson 1
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II.	Directions: List down the steps of the following commands in the spreadsheet 
program. Write your answer on a separate piece of paper.

Selecting Rows and Columns
1.
2.
3.

Inserting and Deleting Rows and Columns
1.
2.
3.
4.
5.

Adding a Worksheet
1.
2.

Lesson 1
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Directions: Give the steps on the following task. Write your answer on a separate 
sheet of paper.

Spreadsheet programs such as Microsoft Excel have features that will 
help you use the program efficiently. But their true power is to handle simple 
and complex mathematical calculations. The next lesson will focus on the 
use of formulas in spreadsheets.

What do you do if 

you want to enter 
data in a cell?

you want the entire 
text displayed but 
it is too long to fit 

inside the cell?

you want to add 
a sheet and 
rename it?

TREADING THE road to mastery
lesson 1
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Using FormulaS AND 
Formatting Cells

After this lesson, learners should be able to

employ good practices in using arithmetic formulas 
and functions in spreadsheets;

create formulas using cell references and arithmetic 
operators;

identify errors in formulas;

employ spreadsheet functions; and

use relative and absolute cell referencing in formulas;

use logical functions.

Setting the Path
lesson 2
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Directions: Supply the missing mathematical and logical operators. Write your 
answers on a separate sheet of paper.

6.	 4           4 = True
7.	 5           2 = True
8.	 7           3 = False
9.	 1           8 = False

10.	 6           1 = True

Did you find it hard to identify the missing operators? Did you know 
that we can also solve mathematical and logical problems using a computer? 
Spreadsheet applications can calculate numbers and solve different problems 
in preparing a workbook. 

1.	 5             5 = 10
2.	 7             3 = 4
3.	 10           2 = 5
4.	 9             3 = 27
5.	 5             5 = 25

TRYING THIS OUT
Lesson 2
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	 Formulas in a spreadsheet are expressions that operate or calculate 
the values in a range of cells, while functions are predefined formulas that 
are already available in spreadsheet applications.

	 The most practical way of entering formulas and functions in Excel is 
to type the equal sign (=) first, followed by the constants and operators.

	 For example, if you want to get the sum of two numbers entered in 
A1+A2, you will put your formula in A3 as =A1+A2.

ENTERING A FORMULA

1.	 To enter a formula, select a cell then type an equal sign (=), followed 
by the cell address of the numbers to be calculated. For example, A3 
is the cell where the formula will be inserted to calculate the input 
numbers in cells A1 and A2.

Understanding What You Did
lesson 2
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2.	 Instead of typing the cell labels, simply the first select cell, type the 
operator, and then select the second cell.

If you change the value in the input cells, the output cell will change as 
well because it has a formula.

3.	 To edit the formula, click the cell on the formula bar and press Enter. 
Alternatively, you can double-click on the cell to change the formula.

You can change the arithmetic operators, such as the division sign 
( / ) and the multiplication sign ( * ).

Lesson 2
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IDENTIFYING ERROR VALUES IN FORMULAS

	 If the intended result is not met after entering a formula, it may 
sometimes lead to error values. This includes errors such as #NAME?, 
#DIV/0!, and #REF!.

#NAME? displays when Excel does not recognize the text in 
a formula. These texts are built-in functions in Excel.

In the example, instead of the word sum, sume was entered. 
To remove the error, simply correct the spelling of the word.

#DIV/0! displays when a number is divided either by zero 
or by a cell that contains no value. 

In the example shown on the next page, instead of A2, the 
cell reference that was entered in the formula was B2, which 
has no value entered. To remove the error, do not divide the 
other number by zero or correct the cell reference in the 
formula.

Lesson 2
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#REF! displays when a cell reference is not valid. 

For example, you may have deleted the row of cell A2. To 
remove the error, press Undo or Ctrl+Z to undo the deletion.

Lesson 2
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USING RELATIVE AND ABSOLUTE 
CELL REFERENCING

	 Cell reference or cell address is a combination of a column letter and 
a row number that identifies a cell on a worksheet. You can see your cell 
reference at the cell address bar. Cell references help Excel find the values 
the formula should calculate.

In Excel, a range is a block of two or more cells.  A range reference is  
represented by the address of the upper left cell and the lower right cell 
separated with a colon. For example, the range A1:D3 contains 12 cells from 
A1 to D3.

Lesson 2



61SPREADSHEETS

There are different types of cell references for creating a formula. These 
are the relative and absolute references. They function differently, so it is 
important to use the appropriate address type.

A relative reference is the default cell references in copying a formula. 
When you use relative, as you copy the formula, the cell reference will change 
according to the position of the cell.

2.	 Type the formula in the output cell. Here, the formula is typed on C2 to 
get the sum of the two numbers.

1.	 To use a relative reference, enter all the data first.

Lesson 2
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3.	 To automatically insert a formula for a range, say C3:C6, use relative 
referencing. Use the fill handle tool on the lower right corner of the 
cell, drag it down until you reach the last cell, and then release the left 
button.

In the example, notice that even if the formula in C2 was copied to the 
cell range C3:C6, there are different answers. This is because in relative 
reference, the position of the cell will change automatically.

7

Lesson 2
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On the other hand, an absolute reference will not change as you 
copy the formula. Absolute reference is especially useful when you want to 
perform multiple calculations with a value in a specific cell or when you need 
to copy a formula to other cells without changing references.

2.	 Enter a new formula in D2, =C2*E7.

3.	 To copy the formula, use the fill handle and drag down until D6.

1.	 Let us create an additional calculation to the previous example. Let us 
multiply all the answers in C2:C6 by a single number placed in E7.

Lesson 2
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After using the fill handle tool, you will notice a zero (0) result. It is 
because a relative reference was used.

4.	 Let us check the result. Click each cell reference and you will notice 
that it follows the next cell reference after E7, which is E8, then E9, 
and so on.

5.	 To make the formula absolute, you need to put a dollar sign ($) in 
the cell reference E7 in the formula. To execute the dollar sign, press 
Shift+4.

Lesson 2
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6.	 After putting a dollar sign, easily apply the formula to the other cells by 
dragging the fill handle until D6. Notice that the only thing that  changed 
is the position of the first cell reference in the formula, which is C2 to C6.

Let us check the formula of the other cell references. It is absolute because  
the E7 cell reference did not change for the rest of the formulas when a 
dollar sign was placed.

Lesson 2
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USING FUNCTIONS

	 Microsoft Excel offers many built-in functions that allow you to perform 
a variety of mathematical operations on the selected cells. 

SUM is used to compute the total of all items in the specified 
range.

AVERAGE is used to get the average of the items in a range.

COUNT is used to count the values found in the range.

COUNTA is used to count cells that contain numbers, 
texts, logical values, error values, and empty texts returned 
in formulas.

ROUND is used to round a number to a specified number 
of digits.

MAX is used to get the largest value within the range.

MIN is used to get the smallest value within the range.

	 One of the ways to enter a function directly to the formula bar is to 
type the function name and its arguments, usually a range of cells.

THE SUM FUNCTION

1.	 Let us prepare sample data to work with.
2.	 To get the total score, you need to use a sum function. In this example, 

you need to enter the formula =SUM(B2:F2) in G2. To get the range 
of the cells, simply highlight the range to be inserted in the formula.

Lesson 2



67SPREADSHEETS

3.	 Use relative referencing to copy the formula to the rest of cells.

The result is 0 because there is no data in the cells yet.

Step 1. Sample Data

Step 2. Sum Function

To use other functions, simply type the name of the function you want 
to use. 

Lesson 2
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THE AVERAGE FUNCTION

	 Let us get the average, total number of quizzes, largest score, and 
smallest score in the quizzes of the previous example. 

1.	 To get the average, enter =AVERAGE(B2:F2).

2.	 Use the fill handle to copy the function to other cells.

Let us enter scores for each student.

Lesson 2
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When you type a function name, a drop-down list of functions 
appears. It means that Excel recognizes the function. You can just 
double-click the function name you want to use from the list.

THE COUNT FUNCTION

In the example on the next page, some results 
are not equal to five because the student missed 
some quizzes.

Drop-down list of 
functions

Automatic entry of 
COUNT function 

1.	 To use the count function, type 
=COUNT([range of cells]). 

You can also double-click COUNT from the 
drop-down list. Here, we type =COUNT(B2:F2)

2.	 When you double-click the function, it will 
automatically be selected, and the next entry 
should be the range of the cell.

The result will be 5, which means there are five 
quizzes. Use the fill handle to copy the formula 
to the rest of the cells.

Lesson 2
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THE COUNTA FUNCTION

 
2.	 =COUNTA(A2:A7) counts the number of data-filled cells in A2 

through A7 and returns a value of 5 because cell A5 is blank. So all 
values are counted except the value in cell A5, which is blank.

 

COUNT Function Example

1.	 If you wish to return the 
number of non-blank cells in 
one cell range, say A2:A7, use 
the COUNTA function. In this 
example, you can see that the 
formula returns the number 
of non-blank cells in the range 
A2:A7.

Lesson 2
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THE ROUND FUNCTION

	 The ROUND function in Excel rounds a number to a specified number 
of digits. Numbers 1, 2, 3, and 4 get rounded down, while 5, 6, 7, 8, and 9 get 
rounded up. Here are examples on how to use the ROUND function.

Round a Number to Two Decimal Places

Round a Number to One Decimal Place

Round a Number to the Nearest Integer

Round a Number to Three Decimal Places

Lesson 2
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THE MAX AND MIN FUNCTION

	 To use the max or min function, type in the formula =MAX([range of 
cells]) or =MIN([range of cells]). In these examples, we type =MAX(B2:F2) 
and =MIN(B2:F2).

	 The maximum number should be 25, and the minimum number should 
be 10. Use the fill handle to copy the formulas to the rest of the cells.

Lesson 2



73SPREADSHEETS

USING THE LOGICAL FUNCTION IF

	 The logical function If is useful in decision-making statements to 
determine if the result is a success or not to the standard being set.

Let us use grades of students as an example. 

2.	 Enter the IF function in the output cell. Here, type in 
=IF(B2>=75, “Passed”, “Failed”) in C2. 

	 If the value in B2 is greater than or equal to 75, it will result in  
a passed remark. Otherwise, if the value in B2 is 74 and below, it will result 
in a failed remark.

1.	 Prepare a sample workbook containing students’ grades in the first 
quarter. The remarks will only display “Passed” or “Failed.”
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	 The remark for C2 will be “Passed” because the statement is true for 
C2; the grade 75 is equal to the value set.

3.	 Use the fill handle to copy the formula. C4 is “Failed” because the grade 
71 is not greater than or equal to 75.

Formulas and functions are the two most essential features of 
Microsoft Excel and other spreadsheet applications. After all, they 
were built to organize and calculate numerical data.

Lesson 2
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FORMATTING NUMERICAL DATA

	 Formatting is different in a spreadsheet when it comes to numerical 
data entered in a cell. When you enter data with numbers, Excel will recognize 
what type of numerical data you are referring to, but you can always change 
it with your desired format. 

DECIMAL PLACES AND SEPARATOR

	 To edit the number format of cells, look for the Number group in the 
Home tab.

You can find the full set of 
number formatting options if you 
click the Dialog Box Launcher in the  
corner of the Number group.
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Let us try to format numbers with decimal places. Excel will display 
the decimal places you entered in the number. 

Some have two decimal places and some only have one because Excel 
displays the zeroes that end a decimal. But for the purpose of uniformity and 
organization, you can choose to format decimal places.

1.	 To format decimal places, click the cell or cell ranges, then click the  
Number Format drop-down list, and then choose Number.

Lesson 2
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Here, the decimal places of the prices in cell range B2:B4 will be displayed 
with two decimals.

2.	 Next, let us calculate first. Here, we compute for the total price of each 
item by multiplying the price by the quantity. 

Use the fill handle to 
copy the formula to D3 
and D4.

3.	 To change the format to two decimal 
places, change the number format to 
Number in the Number group.

Lesson 2
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However, this quick access is not applicable if you want a decimal place 
that is more than two. 

To format it, click More Number Formats... or the dialog box launcher. 
For example, when you use the mathematical operator divide (/) in a 
formula, it is expected to have results with decimal places.

Let us change the decimal places to three. Select the range of cells,  
say C2:C4, then click More Number Formats. A Format Cells dialog 
box will appear. Then, choose Number.

Lesson 2
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The default decimal place is 
2. Change it to 3 by entering 
3 or clicking the arrow up. 
Click OK.

The values will now display three decimal places rounded to the nearest 
thousandths.

	 Let us go back to the 
first example. Total prices 
in thousands do not have a 
separator because they were 
entered as numbers with a
General format. 

	 To add a comma or  a 
thousands separator, select 
the cell range to be formatted 
then click Comma Style in the 
Number group.

Lesson 2
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	 Then, the number format will become Accounting, and a thousands 
separator will be displayed in D4.

Let us change the quantities and prices to see other results.

Lesson 2
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ADDING DATE TYPE, CURRENCY SYMBOL, 
AND PERCENTAGE	

DATE TYPE	

	 From the example in our previous topic, 
let us put a date when the items were purchased 
or bought. The default format for dates is dd/
mm/yyyy. 

	 To change, select E2 then click More 
Number Formats dialog box launcher. Select 
the type that you prefer. For this example, let 
us select the format date/short month/year; just 
scroll down the selection.

	 There are other numerical data that need special formatting. For  
example,  you can choose among the available date formats, depend on the 
currency of a specific country when entering money, and display numbers 
as percentage.

Lesson 2
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The date will be changed to the type assigned. You can do this to other 
dates in the cells. Do not use the fill handle, as it will create a series of dates 
following the first date entered.

CURRENCY SYMBOL

	 Let us put a currency symbol on the price and total prices. Select the 
cell range to be formatted. In this example, we will select B2:B4 and D2:D4. 
To select nonadjacent cells and format cells easily and quickly, press the  
Ctrl key while selecting the cell ranges. 

Lesson 2
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Click the Currency format in the Number group. You can see a Peso 
sign if you are using Microsoft Excel in countries with a Peso currency such 
as the Philippines.

The format will be applied to the selected cell ranges. 

If the data is displayed as a series of number signs or hashtags (#)-
also known as hash or pound sign-it means that the data is longer than the 
default width of the column. Adjust the column width by double-clicking on 
the right side of the header.

Lesson 2



 84 DIGITAL APPLICATIONS

PERCENTAGE

	 How about discounting the price of the items? Let us put a percentage 
in each price. There are two ways to do it. First, enter the numbers.

For the first method, click Percent Style in the Number group.

Lesson 2
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But the percentage displayed two additional decimal places. To solve 
this problem, simply reenter the original numbers 5, 10, and 50.

The second method is to enter the numbers followed by a percent sign 
(%) to avoid reentering the numbers.

To complete our example, let us compute for the less price, discounted 
price, and the total amount due. Create a formula on G2:G4 for the less price 
by multiplying the original price to the percentage discount.
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Next, for the discounted price, create a formula in H2:H4 by 
subtracting the original price to the less price. Freeze columns A and B for 
a while.

For the total amount, multiply the discounted price to the quantity. 
First, freeze columns A, B, and C.

Lastly, compute for the total price on all items, both with original 
prices and discounted prices. Use the SUM function in D5 and I5.

Lesson 2
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FORMATTING CELL APPEARANCE

	 Cells use the same format as default. However, a workbook can have  
a lot of information, so drawing attention to a specific section can 
be difficult. Basic formatting can help you customize your workbook’s 
appearance to make it easier to view and understand.

CHANGING FONT SIZE, FONT, AND FONT STYLE

	 Let us change the font size and font type of the sample workbook about 
the small clothing business. The Font group can be found in the Home tab. 

Now let us change the appearance of cells in the spreadsheet and add 
colors and lines.
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To change the font size, click 
the drop-down arrow and choose  
the desired size, or click the Increase 
Font Size or Decrease Font Size 
button. You can also type a number 
in the text box.

1.	 In this sample, let us change the font size of the headings to 12 and 
the rest of the cells to 10.

Font is located beside the 
Font Size drop-down menu. Click 
the drop-down arrow to choose 
from the variety of fonts or type the 
font if you know the name.
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2.	 Apply the font Arial Narrow to all the cells.

	 You can also apply font styles. Font style can be bold, italic, underline, 
or double underline.

3.	 Let us make all the headings 
bold. Click the B icon in the 
Font group.

4.	 Next, make A2:A4 italic. 
Click the I icon in the Font 
group.
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5.	 Apply underline on D4 and I4, the last prices in the items. Click U in the 
Font group.

There are other font styles 
like double underline. It can be 
seen if you click the arrow on the 
lower right corner of the Font 
group. 

6.	 Apply double underline to D5 
and I5, the sum of each total 
amount. A Format Cells dialog 
box will appear where there are 
options for Underline. Click the 
drop-down arrow then select 
Double Underline.

Alternatively, you can click on 
the drop-down arrow beside the 
U button.

Lesson 2
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APPLYING CELL BACKGROUND AND CONTENT COLOR

1.	 Apply color green to the background of all the headings. Highlight the 
cells first then click the drop-down arrow in the Fill Color command and 
choose green in the Standard Colors. You can also choose among Theme 
Colors or click More Colors.

2.	 Apply a light blue color for the items under Items.

	 To apply colors, click the Fill Color icon for the background and the 
Font Color icon for text or content. Both icons can be found beside each 
other on the Font group of the Home tab.
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3.	 Next, color B2:E4 yellow and F2:I4 red.

4.	 For D5 and I5, let us make the background black and the text white.

To copy formats without changing the content, use Format Painter. 
Select the cell or cell range you want to copy the format then click Format 
Painter in the Clipboard group in the Home tab. Then, apply it to your 
desired cells. Remember that it will copy both the text format and the cell 
appearance format.
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WRAPPING TEXT CONTENT

	 Because Excel cells have a default width, long text contents overlap 
with other cells, but you can easily fix this by adjusting the column widths. 

However,  if you want to 
keep the width as is or shorter so 
that all the information is there 
when you print the file, use the 
Wrap Text command. Wrap Text 
can display long texts by wrapping 
it into multiple lines in a single 
cell.

In our example, Date Purchased and Discounted Price are cropped, 
and Total Amount is overlapping with the J column. To wrap text, click the 
cells and select Wrap Text in the Alignment group in the Home tab.
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The row will automatically adjust its height depending on the font size 
and text entered. Adjust the column widths and row height to arrange the 
wrapped text.

ALIGNING CELL CONTENTS 
HORIZONTALLY AND VERTICALLY

To apply horizontal alignment, select the cells then select align left, 
which is the default alignment; center; or align right. For the example, let 
us align the headings to the center.

For vertical alignment, the default is bottom alignment. You can apply 
top align, middle align, or bottom align. Let us align all the headings in the 
middle of the cell. 
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USING CELL CONTENT ORIENTATION

	 The Orientation command lets you rotate texts vertically or diagonally. 
It is a great way to label narrow columns. Simply click the Orientation 
command in the Alignment group then choose your preferred orientation.

MERGING CELLS

	 Merging cells is to combine two or more cells. This can be useful if you 
want to clarify that a label in Excel applies to multiple columns. The Merge 
& Center command is found in the Alignment group.

Insert a column 
beside column A and 

highlight the two cells. 
Click Merge & Center.
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A1 and B1 were combined without affecting the other cells. To 
unmerge cells, just click the drop-down arrow on Merge & Center command 
then select Unmerge Cells.

APPLYING CELL BORDERS

	 Cell borders allow you to create a clear boundary among the different 
cells of your worksheet. 

	 First, select the cells to be modified then click Borders in the Font 
group and choose what border to apply.

You can also modify the line 
color and line style. Click the drop-
down arrow again and select Line 
Color. Select Light Gray, Background 
2, Darker 10%, and then select the 
style at the bottom of the Line Style 
drop-down list.

You will notice a pencil pointer 
ready to apply the chosen color and 
style.
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Apply this to the borders one 
by one. This lets you personalize your 
worksheets more.

There is so much you can do in 
preparing your workbook. You can 
always improve your spreadsheets and 
create different finance applications, 
tabular records, as well as calculate 
numbers, by using the best features of 
the software program, formulas and 
formatting cells.
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Directions: Determine the formula needed for the following situations. Write 
your answers on a separate sheet of paper.

B.	 Formula to get the remaining balance of each budget

1

C.	 Formula to get the total less price of each item in 20% discount  
(use absolute cell referencing)

2

3

4

5

A.	Formula to get the total number of male and female

Sharpening Your Skills
lesson 2
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Directions: Follow the procedure in creating a monthly budget planner in 
Microsoft Excel. If you do not have a computer, please ask your mobile teacher 
for assistance.

3.	 Wrap Text A3 then adjust column widths. Then, highlight A3:D3, 
apply middle align vertically and align center horizontally.

4.	 Merge cell range B2:D2.

1.	 Open a blank workbook.
2.	 Enter the following data starting from A2 to D3.

TREADING THE road to mastery
lesson 2



 100 DIGITAL APPLICATIONS

5.	 Type “Monthly Budget Planner” in A1. Highlight A1:D1 then apply 
the Merge & Center command.

6.	 Apply the same format below. Include TOTAL in A11.
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7.	 Fill in the cells with the one below. All the numbers should be separated 
by a comma, have two decimal places, and with an Accounting number 
format.

8.	 Enter a formula for the Total 
Budget, Total Actual, and 
Total Difference. Use the 
SUM function.

9.	 Enter a formula for the 
difference of each expense. 
If the answer is negative, 
color the font red.
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10.	 Include the Balance of 
Total Income in A12:B12, 
which should be merged.

11.	 Enter a formula for the 
Balance of Total Income in 
C12. Total Income should 
be subtracted from the 
Total Actual.

12.	 Save your workbook as XLSX in the Documents folder with the file 
name: Monthly Budget Planner_[lastname] (e.g., Monthly Budget 
Planner_Cruz).

How was the activity? Did you find it easy? You can also make your 
own budget plan according to your personal or family income, or create other 
finance planners. Were you able to start analyzing the data in the activity? 
If yes, that is good because spreadsheets should also be used for analyzing 
results after carefully organizing data. Data can also be analyzed visually 
using charts in spreadsheet. 

Lesson 2



103SPREADSHEETS

INSERTING CHARTS AND
FINALIZING SPREADSHEET

After this lesson, learners should be able to

create different types of charts in a spreadsheet;

edit charts in a spreadsheet; and

demonstrate the preparation of outputs in a 
spreadsheet.

Setting the Path
lesson 3
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Directions: Answer the following questions based on the given pie chart of job 
classifications below. Write your answers on a separate sheet of paper.

1.	 How many job classifications are presented in the chart? 
2.	 Which is likely the largest to be applied by the people? 
3.	 What percentage does “Janitorial” have in the chart?
4.	 Which job category has a percentage of 24.8%? 
5.	 What is the overall percentage of the job classifications? 

Were you able to analyze the pie chart properly? If yes, that is excellent 
because it means you are knowledgeable in visual analysis. If not, do not 
worry because this lesson will show you how to present and interpret data 
using charts in a spreadsheet.

TRYING THIS OUT
Lesson 3
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Workbooks that contain a lot of data are sometimes difficult to analyze 
and interpret. Charts allow you to illustrate your workbook data graphically, 
which makes it easy to visualize comparisons and interpret results.

Microsoft Excel has different types of charts that allow you to choose 
what is best for your data. The most frequently used types of charts are as 
follows:

Column charts use vertical bars to 
represent data. They are typically used to 
compare several items in a specific range 
of values.

Bar charts work just like column 
charts, but they use horizontal bars 

instead of vertical bars.

Line charts are ideal for showing trends. 
The data points are connected with lines, 
making it easy to see whether values are 
increasing or decreasing over time.

Understanding What You Did
lesson 3
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Pie charts make it easy to compare 
proportions. Each value is shown as a 
slice of the pie, so it is easy to see which 
values make up the percentage of a whole.

To present data graphically, you should also know how to interpret 
data according to its parts. A chart is usually composed of  a chart title, 
legends, vertical axis, and horizontal axis. You will be able to understand 
each one once you start creating charts in Microsoft Excel.

CREATING A CHART

To create a chart, you must 
first have your data in the 
worksheet. Let us create a 
dummy grading sheet for first 
quarter.

Learners
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1.	 To insert a chart, select the data you will need. In our example, select 
A1:B17. The remarks column is not included.

2.	 Click the Insert tab and find the Charts group.

3.	 Choose the column and bar chart type and click the drop-down arrow to 
choose Clustered Column under 2-D Column as the subtype. A column 
chart will be displayed on the right side of the worksheet.
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To change a chart type, select the chart, click the Line Chart icon in 
the Charts group. Select Line in 2-D Line.

To resize, simply select any corner of the chart then hold the mouse 
and resize. 
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You can move a chart by dragging it to any location in a worksheet. To 
delete a chart, just select the chart then press the Del key on the keyboard.

4.	 Let us delete the first chart and 
update our data. 

5.	 Click Line Chart in the Charts 
group and choose Line with 
Markers.

Learners

Learner1
Learner2
Learner3
Learner4
Learner5
Learner6
Learner7
Learner8
Learner9
Learner10
Learner11
Learner12
Learner13
Learner14
Learner15

Lesson 3



 110 DIGITAL APPLICATIONS

Since the data was updated, you will now see two lines: one for the 
First Quarter Grade and one for the Second Quarter Grade.

You will see that another part of the chart appears because of the 
additional data, but there was no chart title assigned; instead, it just has a 
“Chart Title” caption. To edit the chart title, click on the area of the chart title 
then replace it with “First and Second Quarter Grades.”
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To remove a chart, click the plus sign button or Chart Elements at 
the right corner of the chart then uncheck Chart Title. If you want to add a 
title, check Chart Title.

To edit the legend at 
the bottom, right-click the 
legend then choose Select 
Data.

Then, choose the legend to be edited. Click Edit on the dialog box.
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In the Series Name, type First Quarter. Repeat the same procedure for 
Series 2. Then, click OK.

The legend is now changed.

Learner1
Learner2
Learner3

Lesson 3
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CHANGING COLORS IN A CHART

	 To change colors, select the chart and click the Chart Design tab. 
Choose Change Colors then pick a set of colors.

	 To change the background color and text color of the chart, select the 
parts that you want to change the color, then select Format beside Chart 
Design.

	 To change the color of the background, choose Shape Fill in the Shape 
Styles group; for the text color, choose Text Fill in the WordArt Styles group.
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To change the font, font size, font color, or font style on the text of each 
part, simply use the Font group in the Home tab.

These formats can be applied to different types of chart available in 
Microsoft Excel.
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FINALIZING A SPREADSHEET

	 Before printing the spreadsheet, check its setup.

	 Let us begin with the page setup of the spreadsheet. Page Setup is in 
the Page Layout tab, which includes the margins, paper size, and document 
orientation.

MARGINS

To edit the margins, click 
Margins. Decide which option you 
need for your spreadsheet. Normal 
is the default, but if you like none of 
the options, customize with Custom 
Margins.

Lesson 3
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When you apply changes in the margin, you will not be able to see the 
effect unless  you go to Print Preview. From there, click Show Margin in the 
lower right corner of the preview to adjust the margins manually.

Margins will now be visible for manual adjustment. Just click and drag 
the lines to apply changes.

Lesson 3
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SIZE AND ORIENTATION

	 Paper Size can be set up before you begin doing 
your spreadsheet. The default size is Letter size, but you 
can always choose which one you need.

	 Unlike word processors, you are unable to see  
the paper size in spreadsheets until you set up the size 
or go to Print Preview. 

	 Once you have set up the size, you will see a 
marquee line indicating the boundary of the page.

	 Notice that the half of the chart overlapped 
the marquee line. It means that only the first half of 
the chart will be included on the first page. Printing 
spreadsheets is challenging, especially if you are only 
limited to common paper sizes.
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But if you are aiming for a portrait orientation, adjust the margins 
or scale of the spreadsheet. Click the Scaling option on Print Preview then 
choose Fit Sheet on One Page.

To fix this problem, you can put the chart after the data above or 
simply change the orientation from Portrait to Landscape.

Lesson 3
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You may use Show Margins to 
enlarge the scale.

Scaling Options

Lesson 3
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HEADER AND FOOTER

To add a header and footer, open the Page Setup dialog box. 

In the Header/Footer tab, 
you will see that Excel already 
has a number of presets based on 
your worksheet when you click on 
the Header or Footer drop-down. 
You may choose from the list or 
customize your own.

To customize your header or footer, click Custom Header or Custom 
Footer. A header or footer dialog box will open. Click the left, center, or right 
section and type your own header or footer.

Custom Header Dialog Box

Lesson 3
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Customize your header or footer with the different available formatting 
options just above the text boxes. 

Format Text
Insert Number 

of Pages Insert Time
Insert 

File Name Insert Picture

Insert 
Page Number

Insert Date Insert 
File Path

Format 
Picture

Insert 
Sheet Name

Let us write “Alternative Learning System” for our header and add 
some text formatting.

Lesson 3
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Alternatively, you can also 
find Header & Footer in the Insert 
tab of the Text group.

The display will change to 
the Page Layout view where you 
will see a Header panel on top and 
a Footer panel at the bottom. The 
Header & Footer Design tab will 
also appear on the Ribbon.

Click on the text box and type your new header or footer.

Lesson 3
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Besides the marquee lines that indicate the boundary of 
the page, you cannot see the worksheet’s margins, size, 
orientation, header, and footer in Normal view. Go to Print 
Preview or the Page Layout view to view them.

Edit your header and footer with the formatting tools available on the 
Header & Footer Design tab.

Header Preview through Print Preview

Lesson 3
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PREVIEWING AND PRINTING SPREADSHEETS

	 It is important to preview your output first to avoid errors and waste 
of paper.

1.	 Select the Print Preview button on the Quick Access Toolbar or press 
Ctrl+P on the keyboard.

2.	 Choose the active printer on 
Printer, and then indicate the 
number of copies to be printed 
on Copies. 

To print specific pages, type in 
the pages you want to include. If 
there are five pages but you only 
want to print pages 1 to 3, then 
type 1 on the first box and 3 on 
the second box. If you only want 
page 2, then type 2 on the first 
box. If you are going to print the 
entire workbook, leave it blank.

Charts are used to visually present and interpret data. You will 
probably encounter charts on other office productivity tools and the 
same procedure in creating charts can be applied on those tools.

Lesson 3
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Directions: Using a Venn diagram, compare and contrast the different types of 
charts used in a spreadsheet by listing down their characteristics and features. 
Do this activity on a separate sheet of paper.

1.	

2.	

Column Chart Bar Chart

Line Chart Pie Chart

Sharpening Your Skills
lesson 3
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Directions: Follow the procedure to practice creating a pie chart. If you do not 
have a computer, please ask for assistance from your mobile teacher.

3.	 Select the data from A2:B7.
4.	 Click the Insert tab and go to the Charts group. Select 3-D Pie on Pie 

Chart.

1.	 Open a new blank workbook in Microsoft Excel.
2.	 Use some data about the recommended diet. Enter the following data 

in the worksheet.

TREADING THE road to mastery
lesson 3
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5.	 Change the chart title “Percentage” to “Recommended Diet.”

6.	 Change the chart style of the pie chart. Select Style 3 on Chart Style 
on the Chart Design tab.

Lesson 3
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7.	 Save the worksheet with file name: PieChart_[lastname]
(e.g., PieChart_Mendoza.xlsx).

Spreadsheet applications are effective and convenient tools that help 
make tasks easier and more accurate.

Lesson 3
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“
“

•	 Spreadsheet, or worksheet, is an arrangement of cells in 
columns and rows used to organize, analyze, calculate, 
and report information, usually in numerical form.

•	 The basic parts of a spreadsheet are rows, columns, 
cell, active cell, cell address, formula bar, and sheet 
tabs.

•	 Workbook is a file where spreadsheets are contained.

•	 A cell is made up of rows and columns.

•	 AutoFill allows automatic entering of data based on 
a pattern. 

•	 The row height and column width can be adjusted 
through its headers.

•	 You can add two or more sheets in a workbook.

•	 Formulas in a spreadsheet are an expression that 
operates or calculates the values in a range of cells or 
a cell.

•	 Functions (sum, average, count, max, and min) are 
predefined formulas that are already available in Excel. 

MODULE 3

Don’t Forget
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“
“

•	 Cell reference or cell address is a combination of a 
column letter and a row number that identifies a cell 
on a worksheet.

•	 There are two types of cell references, the relative and 
absolute references.

•	 The logical function If is useful in decision-making 
statements to determine if the result is a success to the 
standard being set.

•	 Microsoft Excel has a command called Number 
Format to change the format of numerical data.

•	 Wrap Text allows long texts to be displayed on multiple 
lines but in a single cell.

•	 Charts allow you to illustrate your workbook 
data graphically, which makes it easy to visualize 
comparisons and interpret results.

•	 The four basic types of charts are column chart, bar 
chart, line chart, and pie chart.

•	 The header and footer in a spreadsheet can be seen in 
Print Preview.

MODULE 3
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https://www.edu.gcfglobal.org

https://www.excel-easy.com

To learn more about spreadsheets, visit the following websites:

Explore more
MODULE 3
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Directions: Identify the word being described in each statement. Choose 
your answer from the word pool and write it on a separate sheet of paper.

$ Ctrl key Shift key Pie Chart Count

Relative 
Reference Formula Bar Google Sheets Spreadsheet Columns

Formula & Average Fill  
Handle Sum

Cell  
Reference .doc XSLX Absolute 

Reference #

Line Chart #REF! Wrap Text Workbook =

Fill Color #DIV/0! Functions #NAME? Charts

Ribbons Comma Cell If Rows

1.	 This is where spreadsheets are contained. 

2.	 It is the individual intersections between rows and columns. 

3.	 It shows the contents of the active cell and allows you to create and 
view formulas. 

4.	 It is a free online spreadsheet program. 

5.	 This is the default file type of Microsoft Excel. 

6.	 This is a tool to use in copying cell contents automatically. 

7.	 These are vertical lines for data in a spreadsheet. 

8.	 It is used to start a formula in the formula bar. 

9.	 This error displays when a number is divided either by zero or by a 
cell that contains no value. 

10.	 It is the arrangement of cells in columns and rows used to organize, 
analyze, calculate, and report information. 

11.	 This is an expression that operates or calculates the values in a range 
of cells or a cell. 

Reach The Top
MODULE 3
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12.	 These are divided into logical groups called tabs, and each tab has its 
own set of unique functions to perform. 

13.	 This is the key to press in the keyboard when selecting nonadjacent 
cell or cells. 

14.	 This error displays when a cell reference is not valid or deleted. 

15.	 These are horizontal lines for data in a spreadsheet. 

MODULE 3
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answer key

LESSON 1: UNDERSTANDING SPREADSHEETS 

TRYING THIS OUT
1.	 10

PAGE 5

PRE-ASSESSMENT

1.	 horizontal
2.	 vertical
3.	 cut
4.	 cell
5.	 font styles 

PAGE 2

6.	 font type
7.	 cells
8.	 fill color
9.	 horizontal

10.	 mathematical

2.	 Spreadsheet
3.	 40%
4.	 4
5.	 Monday, Tuesday, Wednesday, 

Thursday, Friday, Saturday, 
Sunday

6.	  =
7.	 10:00 AM
8.	 88.5
9.	 02/09/2020

10.	 1,000

SHARPENING YOUR SKILLS
ACTIVITY I

1.	 Tabs
2.	 Ribbons
3.	 Quick Access Toolbar
4.	 Cell Address
5.	 Rows

6.	 Columns
7.	 Formula Bar
8.	 Cell
9.	 Sheet Number

10.	 Add Sheet

PAGE 51

11.	 pie chart
12.	 functions
13.	 comma
14.	 sum
15.	 fill color

ACTIVITY II

Selecting Rows and Columns
1.	 To choose a row or column, click the row header (number) 

or column header (letter).
2.	 To click more than one row or column, hold your mouse 

from the headers then hold the left click and drag the mouse 
vertically or horizontally.
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TREADING THE ROAD TO MASTERY
1.	 Select the cell and type the desired data.
2.	 Double-click the cell width after the cell box where the text 

was entered.
3.	 Click the add button sheet then right-click the Choose 

Rename command then change to the desired sheet name.

PAGE 53

answer key
3.	 To select nonadjacent rows and columns, click the desired 

rows and columns header while pressing the Ctrl key on the 
keyboard.

Inserting and Deleting Rows and Columns
1.	 To insert row or rows in between, right click on the row 

header and click Insert.
2.	 To insert more than one row, select the desired number of 

row headers and click Insert. The selected rows correspond 
to the number of new rows.

3.	 To insert column or columns in between, right click the 
column header click Insert.

4.	 To insert more than one column, select desired number 
of column headers then click Insert. The selected columns 
correspond to the number of new columns.

5.	 To delete cell or cells, do the same procedure in inserting rows 
or columns, but instead of Insert, click the Delete command.

 
Adding Worksheet

1.	 To add another sheet, click the plus sign button beside Sheet1.
2.	 A new sheet will appear with Sheet2 as the name. You can 

continue doing this if you need more worksheets.
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answer key
LESSON 2: USING FORMULAS AND FORMATTING CELLS 

TRYING THIS OUT
1.	 +
2.	 −
3.	 ×
4.	 ×
5.	 =

PAGE 55

6.	 >
7.	 <
8.	 >
9.	 >

SHARPENING YOUR SKILLS
1.	 =A2+B2
2.	 =B2−C2
3.	 =B3−C3
4.	 =B2*$A$6
5.	 =B3*$A$6

PAGE 98
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answer key
LESSON 3: INSERTING CHARTS AND FINALIZING 

SPREADSHEETS 

TRYING THIS OUT
1.	 5
2.	 Manufacturing
3.	 8.3%
4.	 R & D
5.	 100%

PAGE 104

REACH THE TOP

1.	 Workbook
2.	 Cell
3.	 Formula Bar
4.	 Google Sheets
5.	 XSLX

PAGE 132

6.	 Fill Handle
7.	 Columns
8.	 =
9.	 #DIV/0!

10.	 Spreadsheet

11.	 Formula
12.	 Ribbons
13.	 Ctrl key
14.	 #REF!
15.	 Rows
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Absolute
Viewed or existing independently and not related 
to others; not relative or comparative.

Accounting The action or process of keeping financial 
accounts.

Analyze To examine something to find out what it is or 
what makes it work.

Calculate To determine the amount or number of 
something mathematically.

Currency A system of money in general use in a particular 
country.

Data
Facts and statistics collected together for 
reference or analysis.

Decimal Place The position of a digit to the right of a decimal 
point.

Information The summarization of data.

glossary

Interface
A device or program enabling a user to 
communicate with a computer.
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Interpret To describe the meaning of something.

Organize To arrange into a structured whole.

Proportion
The size, number, or amount of one thing or 
group of things as compared to that of another.

Relative
Considered in relation or in proportion to 
something else.

Templates
A preset format for a document or file, used so 
that the format does not have to be recreated each 
time it is used.

glossary
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